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About Harmony Preferences

The Preferences dialog box allows you to adjust preferences to suit your workflow and your production's 

needs.
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Accessing the Preferences Dialog

Accessing the Preferences Dialog 

You can access the Preferences dialog from the Edit menu on W indows and GNU/Linux, or from the Harmony 

Premium menu on macOS. 

How to open the Preferences dialog box

 1. Do one of the follow ing:

 l W indows or GNU/Linux:

 l In the top menu, select Edit > Preferences.

 l Press Ctrl + U.

 l macOS:

 l In the top menu, select Harmony Premium > Preferences.

 l Press ⌘  + U.

4



Switching Between Preference Sets

Harmony comes preloaded w ith five different preference presets (referred to as preference sets), each tailored 

for a different kind of task. By default, the Basic preference set is used. You can choose which preference set to 

use in Preferences dialog.

A large part of the default settings in the different preference sets are the same. The follow ing table describes 

which option is different depending in each preference set, and how:

Tab / 

Location
Preference

Preference Set

Basic Compositing
Cutout 

Animation

Paperless 

Animation
Rigging

General

Focus on 

Mouse Enter
Off On On On On

Default pass 

Through 

Composite

Off Off On Off On

Default 

Separate 

Position for 

Pegs

Off Off On Off On

Stop-Motion 

Keyframes
Off Off On Off On

Timeline

Reduce 

Indentation
Off On On Off On

Drawing 

Substitution: 

Create Key 

Exposure

On Off Off Off On

Advanced

Support 

Overlay and 

Underlay 

Arts

Off On On Off On

Advanced Off On Off Off On
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Switching Between Preference Sets

Tab / 

Location
Preference

Preference Set

Basic Compositing
Cutout 

Animation

Paperless 

Animation
Rigging

Display

Advanced 

Palette List
Off On On On On

Advanced 

Element 

Mode

Off On Off Off Off

Element 

Node 

Animate 

Using 

Animation 

Tools

On On Off On Off

Pencil Tool 

Properties

Auto Close 

Gap
On On On On Off

NOTES 

 l W hen you customize a preference manually, it is not saved to the current preference set. It is 

saved as an override for all preference sets. 

 l Switching between preference sets only affects preferences that you have not manually 

customized yourself.  This means, for example, that if you manually enable the Focus on Mouse 

Enter preference, this preference w ill no longer be affected when you switch to a different 

preference set. 

 l To make all your preferences affected by the preference set you select again, you must reset 

your preferences—see Resetting Preferences on page 10.
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How to switch between preference presets

 1. Do one of the follow ing to open the Preferences dialog:

 l W indows or GNU/Linux:

 l In the top menu, select Edit > Preferences.

 l Press Ctrl + U.

 l macOS:

 l In the top menu, select Harmony Premium > Preferences.

 l Press ⌘  + U.

 2. In the top-left corner of the Preferences dialog, open the Preference Set drop-down and select the 

preset you want to use.

Preferences w ill be updated according to the table above, except for those that you manually set. 

 3. Click on OK. 
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Exporting Preferences

Exporting Preferences

You can export your current preferences to an XML file. You can reimport this file later to restore your 

preferences, or share it w ith project collaborators so that you all use the same preferences.

NOTE 

W hen you export your preferences, only the preferences for the currently selected preference set 

are exported. 

How to export your preferences configuration

 1. Do one of the follow ing to open the Keyboard Shortcuts dialog:

 l W indows or GNU/Linux:

 l In the top menu, select Edit > Preferences.

 l Press Ctrl + U.

 l macOS:

 l In the top menu, select Harmony Premium > Preferences.

 l Press ⌘  + U.

 2. Near the top of the dialog, right of the Preference Set: drop-down, click on the  Save... button.

A save dialog appears.

 3. Browse to the location where you want to save your preference file.

 4. Type in the desired name for your preference file. 

 5. Click on Save.

Your current preference settings have been exported as an XML file, in the selected location w ith 

the file name you gave it.
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Importing Preferences

You can import a preference file exported from Harmony. 

NOTES 

 l To export preferences into a file, see Exporting Preferences on page 8.

 l W hen you import a preference file, it w ill override all your preferences for the currently 

selected preference set. 

How to import a keyboard shortcut configuration file

 1. Do one of the follow ing to open the Keyboard Shortcuts dialog:

 l W indows or GNU/Linux:

 l In the top menu, select Edit > Preferences.

 l Press Ctrl + U.

 l macOS:

 l In the top menu, select Harmony Premium > Preferences.

 l Press ⌘  + U.

 2. At the right of the Preference Set: drop-down, click on the  Load... button.

An open dialog appears.

 3. Browse to the directory where your preference file is located.

 4. Select the preference file you want to import.

 5. Click on Open.

The settings in the selected preference file are loaded into the Preferences dialog, overwriting your 

current preferences.
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Resetting Preferences

Resetting Preferences

You can reset the preferences in Harmony to their default settings.

IMPORTANT 

This w ill permanently undo all the changes you made to your Harmony preferences.

How to reset your keyboard shortcuts configuration

 1. Do one of the follow ing to open the Keyboard Shortcuts dialog:

 l W indows or GNU/Linux: In the top menu, select Edit > Keyboard Shortcuts.

 l macOS: In the top menu, select Harmony Premium > Keyboard Shortcuts.

 2. In the bottom-left corner of the Preferences dialog, click on Restore All Defaults.

A confirmation prompt appears.

 3. If you are sure you want to restore the default preferences for Harmony, click on Yes.

All the preferences in the Preferences dialog are now set to their default setting.

10



Preferences File Location

T-HFND-002-002

After the first time you have launched Harmony, your preferences, along w ith numerous other options and 

switches in the user interface, are stored in a hidden directory on your computer. If you are using Harmony 

Server, they are stored in a directory for your user on the database server. 

Depending on your operating system, and whether or not you are using Harmony Stand Alone or Harmony 

Server, you can find your preference files in the follow ing location:

 l W indows: C:\Users\[username]\AppData\Roaming\Toon Boom Animation\Toon Boom Harmony 

Premium\full-2000-pref

NOTE 

On W indows, the AppData folder is hidden. To display it in Explorer, in the top menu, open 

the View pane and check the Hidden Items checkbox. 

 l macOS: /Users/[username]/Library/Preferences/Toon Boom Animation/Toon Boom Harmony 

Premium/full-2000-pref

NOTE 

On macOS, the Library folder is hidden. To display it in Finder, hold down the Alt key.

 l GNU/Linux: /home/[username]/Toon Boom Animation/Toon Boom Harmony Premium/full-2000-pref/

W hen using Harmony Server, preferences are stored in your Harmony Server account's user space on the 

database server, in the follow ing path:

 l /USA_DB/users/[user_name]/Harmony Premium/full-2000-pref
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Preferences Dialog Reference

Preferences Dialog Reference

The follow ing section contains a an article for each tab in the Preferences dialog. Each article contains a list of 

all the preferences in its tab, as well as a description of the preference. Refer to this section if you want to 

know more about what a specific preference does or if you want to get familiarized w ith all of the preferences 

in Harmony.

General Preferences 13

Camera Preferences 22

Node View Preferences 25

Exposure Sheet Preferences 28

Drawing Preferences 31

Timeline Preferences 36

Template Preferences 38

Sound Preferences 39

OpenGL Preferences 40

Render Preferences 44

Advanced Preferences 46

Deformation Preferences 51

Particle Preferences 52
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General Preferences

To customize your interface, you w ill use some of the preferences located in the General tab as well as the 

Camera tab.

Parameter Description

Save 

In Harmony Server, you can decide which kinds of assets are saved when 

you use the Save command. This can be useful if you need specific users to 

only be able to make changes to certain aspects of the scene they're 

working on, or if you want to prevent yourself from accidentally making 

undesired changes to important assets. Unchecking any of the follow ing 

options w ill prevent you from saving their corresponding type of assets: 

 l Save Scene: Save changes to the list of layers, the node system, 

elements, animation, timing, layout, effects, scene properties, etc.

 l Save Palette Lists: Save changes to the list of palettes associated to 

the scene or to individual elements.

 l Save Palettes: Save changes to the colours and textures contained 

in palettes. 
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Preferences Dialog Reference

 l Save Drawings: Save changes to existing drawings as well as 

newly created drawings.

TIP 

If you want to save changes made to a type of asset that for which 

saving was disabled, you can do so by selecting File > Advanced 
Save from the top menu. In the Advanced Save dialog, assets for 

which saving is disabled w ill be unchecked, so you must manually 

check the assets you want to save.

IMPORTANT 

W hen you close a scene, Harmony w ill not ask for confirmation to 

discard changes made to assets for which saving is disabled. 

Open in Read Only mode if plugin syntax errors are detected: Opens 

scenes that contain plugin node errors in read-only mode to prevent you 

from losing plugin information on subsequent saves.

Auto-Save:

 l Interval (minutes): This is the frequency at which the auto-save 

takes place.

 l Inactivity Interval (seconds): W hen Auto-save is about to take 

place, it verifies if you are drawing or doing anything in the 

application. If so, Auto-save waits this number of seconds before 

attempting another save.

 l Ask Before Saving: Before performing an auto-save, the system will 

prompt you w ith a message to confirm if you want to save or not. 

You can choose to turn off this option.

 l Enabled: This enables the Auto-save feature. If you do not want the 

system to automatically save your work, deselect this option. The 

auto-save is off by default.

Automatically Save W orkspace: Changes to your workspace, such as how 

views and toolbars are laid out, are automatically saved, making sure your 

workspace remains the same after you close and re-launch Harmony or if 

you switch between different workspaces. If this option is disabled, you 

must manually save changes to your workspace by selecting W indows > 

W orkspace > Save W orkspace from the top menu.

Colour Management

Default to Element Palette Lists: W hen this option is enabled the new, 

cloned, duplicated, imported and linked palettes w ill be stored in the 

Element Palette list instead of the Scene Palette List.

Interactive Colour Recovery: If a colour palette required to display a 
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drawing is not found because it was moved or deleted from its location, you 

w ill be asked if you w ish to recover the missing colours into a new 

temporary palette. If this option is disabled, the colour recovery w ill happen 

automatically w ithout your confirmation.

Colour Recovery: By default, if a colour palette required to display a 

drawing is missing because it has been moved or deleted, Harmony 

recovers the missing colours into a new temporary palette. If this option is 

disabled, Harmony w ill skip this step and display the zones painted w ith 

missing colours w ith the Replacement Colour, which is solid red by default. 

Replacement Colour:  If certain colours are no longer available, Harmony 

w ill display the replacement colour in the zones painted w ith missing 

colours.

Colours

You can select the colours for a lot of coloured elements in the user 

interface of Harmony. 

NOTE 

Some changes to colour preferences may not appear until Harmony is 

restarted or until the affected view is closed and reopened.

Current View Border:Sets the colour of the frame around the workspace 

view you are currently using, also known as focus. By default, the colour is 

red. Click on the red colour swatch to select a new colour in the Colour 

Picker w indow.

Current View Border in Template Edit: Sets the colour of the frame around 

the workspace view you are currently using when editing a template from 

your library view. By default, the colour is green. Click on the green colour 

swatch to select a new colour in the Colour Picker w indow.

Edit Colours: The Edit Colours button opens the Colours dialog, which 

allows you to set the colour for dozens of visual elements in the user 

interface.
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Preferences Dialog Reference

3D Models

Default Scale Factor: The default scale factor to apply to a 3D model when 

it is imported into your scene. You can enter a decimal value between 0 and 

1 to make newly imported 3D models appear smaller than their original 

size, or a decimal value greater than 1 to make 3D models appear bigger 

than their original size.

Options

Support Gestures: Enables manipulating views such as the Camera and 

Drawing views using the follow ing gestures:

 l To pan the view, drag your two fingers in any direction, keeping both 

fingers at the same distance from each other.

 l To zoom in, drag your two fingers away from each other.

 l To zoom out, drag your two fingers closer to each other.

 l To rotate, drag your two fingers in a curve so that they revolve in the 
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same direction.

Invert Scroll Direction: W hen panning a view by dragging it w ith your 

fingers in one direction, this makes the view pan in the opposite direction.

Touch Sensitivity: Control touch sensitivity. On macOS, higher numbers 

give a slower response to pans. On W indows, higher numbers favour 

scale/rotates over pans.

Auto Apply: W hen enabled, values entered or options selected in node 

editors are automatically applied to elements in your scene. The Apply and 

OK buttons are hidden in the Layer Properties when this feature is enabled.

Snap Keyframe: If two keyframes have the same value, they w ill both 

update to the same new position when the first of the two keyframes is 

modified. The previous keyframe has to be a Stop-Motion keyframe.

Auto-Get Rights to Modify Drawings: W hen using Harmony Server, this 

option w ill automatically grant you the right to modify a drawing as soon as 

you attempt to make a change to it. If disabled, you must manually obtain 

the rights to each drawing you want to make changes to.

Auto-Get Rights to Modify Palettes: W hen using Harmony Server, this 

options automatically grants you the right to modify the colour and texture 

swatches in a palette as soon as you attempt to make such changes. If 

disabled, you must manually obtain the rights to modify a palette before 

attempting to make changes to it.

Auto-Get Rights to Modify Palette List: W hen using Harmony Server, this 

option automatically allows you to make changes to the palette list. If 

disabled, you must manually obtain the right to the palette list before 

adding, removing or reordering palettes. 

Editors Always on Top: Displays Function Editor and Layer Properties 

dialogs over other dialogs.

Close Previous Editors: W hen opening a new Layer Properties or Function 
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Preferences Dialog Reference

Editor dialog, automatically close other such dialogs. 

Focus on Mouse Enter: In Harmony, some keyboard shortcuts, menus or 

toolbar buttons are intended for specific views in your workspace. To use 

keyboard shortcuts or other functionalities on a specific view, this view must 

be focused on. For example, the Centre on Selection shortcut w ill find the 

selected element in the Timeline, Camera or Node view, depending on 

which one is focused on. Harmony draws a red rectangle around the 

currently focused on view. 

By default, to set the focus on a view, you must click on its tab or on 

anything inside the view itself. The Focus on Mouse Enter preference w ill 

make Harmony automatically focus on the view the mouse cursor is over, 

making it sw itch the focus on a view and use keyboard shortcuts on it. 

NOTE 

Some items in the top menu also have functionalities that are specific 

to the focused on view, but moving the mouse cursor to the top menu 

might leave the wrong view focused on. To circumvent this problem, it 

might be necessary to become familiar w ith keyboard shortcuts, 

contextual (right-click) menus and the view menus available via the 

menu  button at the top-left corner of some views.

Shortcut Zooms on Mouse: W hen enabled, shortcut zooming w ill centre on 

the cursor location.

Auto Render:Controls whether the Camera view 's Auto Render option is 

enabled or disabled when launching Harmony. W hen Auto Render is 

disabled, if any change is made to the scene while the Camera view is in 

Render Preview mode, it w ill sw itch to OpenGL Preview mode. W hen 

enabled, it w ill merely refresh the render preview. 

Cycle Exposure: Make navigation in the Xsheet View wrap-around from the 

last frame or the last column to the first. 

Display Cardinal Coordinates: W hen enabled, coordinates displayed in the 

application are expressed using cardinal points. For example, 1N2E means 

1 field to the north and 2 fields to the east. W hen disabled, coordinates are 

expressed in scalar notation. For example, 1N2E would be expressed as 

+1,-2. 

Flat Tool Toolbar (Requires Relaunch): W hen enabled, the Tools toolbar 

w ill display each tool in its own button, instead of grouping certain tools 

together in pop-up menus. Harmony must be relaunched to apply a change 

to this preference.
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IMPORTANT 

Because not all tools can be displayed simultaneously in a single 

column, some tools w ill be hidden from the Tools toolbar by default. 

You can customize which tools appear in the Tools toolbar by right-

clicking on it and selecting Customize.

Use Dark StyleSheet (Requires Relaunch): Application loads a dark skin 

for the User Interface. 

Language

Language (Requires Relaunch): The language in which to display the user 

interface. 

By default, this is set to Autodetect, which means that Harmony w ill launch 

in the language of your operating system, if it is one of the supported 

languages, and w ill otherw ise launch in English.

Settings

Default Separate Position for Pegs: New pegs are created w ith separate 

position functions.

Default Separate Scale for Pegs: New pegs are created w ith separate 

scale functions.

Default Separate Position for Elements: New elements are created w ith 

separate position functions.

Default Separate Scale for Elements: New elements are created w ith 

separate scale functions.

Stop-Motion Keyframes: New keyframes are created as stop-motion 

keyframes. 

Default Bezier: New functions curves are created as Bezier Curves.

Default Bezier Velocity: New velocity curves are created as Bezier Curves.

Default Pass Through Composite: New composite nodes are created in 

w ith their Mode parameter set to Pass Through mode instead of As Bitmap 

.

Field Chart: 

 l X:  Default value for the number of units in the X axis (east-west) of 

the field chart used for new scenes. This value should be half the 

total number of units in the X axis of the field chart. This value w ill 

appear by default in the Alignment dialog box. 

 l Y: Default value for the number of units in the Y axis (north-south) of 

the field chart used for new scenes. This value should be half the 

total number of units in the Y axis of the field chart. This value w ill 

appear by default in the Alignment dialog box. 
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Preferences Dialog Reference

 l Z:  Default value for the number of units in the Z axis (front-back) of 

the field chart used for new scenes.  This value w ill appear by default 

in the Alignment dialog box. 

Levels of Undo: Determines the number of actions retained by the Undo 

list. By default, 50 actions are stored in the list. You can alter the number if 

you want to.

Touch Interface

Support Gestures: Enables manipulating views such as the Camera and 

Drawing views using the follow ing gestures:

 l To pan the view, drag your two fingers in any direction, keeping both 

fingers at the same distance from each other.

 l To zoom in, drag your two fingers away from each other.

 l To zoom out, drag your two fingers closer to each other.
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 l To rotate, drag your two fingers in a curve so that they revolve in the 

same direction.

Invert Scroll Direction: W hen panning a view by dragging it w ith your 

fingers in one direction, this makes the view pan in the opposite direction.

Touch Sensitivity: Control touch sensitivity. On macOS, higher numbers 

give a slower response to pans. On W indows, higher numbers favour 

scale/rotates over pans.

W eb Control Center

This setting is only available in Harmony Stand Alone. It is made to allow 

Harmony to connect to a W ebCC server. W hen working on a scene 

exported from W ebCC, you can download changes made to the scene from 

the database and upload changes you made to the database from Harmony. 

URL: The full URL to the W ebCC server, including the protocol and port 

number, as you would type it in a web browser:

protocol://hostname:portnumber

For example, to access a server named webcc.mystudio through https via 

port 8843, you would enter:

https://webccserver.mystudio:8843

NOTE 

If the URL starts w ith the name of the server rather than the protocol, 

http is presumed.
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Camera Preferences

Parameter Description

Tools

Initial Animation Mode: Determines which animation mode is enabled when the 

scene is opened.

Show Locked Drawings As Outlines:  In the Camera view, locked elements are 

displayed as outlines only.

Bounding Box Selection Style: In the Camera view, selected elements are not 

highlighted in colour but displayed w ith the bounding box only. 

Nudging Factor: The nudging increment value.

Set Keyframe on All Functions with the Transform Tool: W hen this option is 

selected, the Transform tool w ill create a keyframe for all functions of the 

selected pegs, including the functions that normally would not be affected by the 

transformation.

Set Keyframe at Frame One with First Application of the Transform Tool: 

W hen this option is selected, wherever you set a keyframe on a layer, a keyframe 

is added on your frame 1. If this options is deselected, a keyframe is only added to 

the current frame. If later on, you add a keyframe on your frame 1, it may modify 

the first keyframe you added.
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Paste/Drag&Drop Adds Keyframes at Beginning and End: Select this option to 

copy and paste a set of frames that includes an interpolated sequence between 

two keyframes, but only extracts a partial section. Under normal circumstances, 

cutting and pasting a function w ithout either the start or end keyframe would 

render the function null. This option caps the partial function w ith a new keyframe 

when you perform the paste.

Use Rotation Lever with Transformation Tools: Lets you see the rotation lever 

when using the transformation tools. W hen this option is deselected, hovering 

your cursor over the corner of an element’s bounding box is sufficient to rotate it.

Zoom Settings
Camera View Default Zoom: The default zoom value for the Camera view. 

Top/Side View Default Zoom: The default zoom value for the Top/Side views. 

Settings

Thumbnail Size: The thumbnail size, in pixels, that appears in the Top and Side 

views.

The size, in pixels, of the smaller bitmap version of your image. W hen you import 

a bitmap image into a scene, a smaller version of it is created in order to 

accelerate the compositing and playback processes.

Override Small Bitmap Files: Enable this option if you want the system to 

generate new versions of the existing smaller bitmap files, every time you modify 

the Small Bitmap Resolution value. W hen the option is disabled, the existing 

smaller bitmap versions w ill not be regenerated and w ill keep the same 

resolution as when they were created.

TV Safety: The ratio value for the TV Safety frame in proportion to the regular 

camera frame.

Proportion Grid

Horizontal Divisions: This allows you to set the value for horizontal divisions in 

Proportion Grid.

Vertical Divisions: This allows you to set the value for vertical divisions in 

Proportion Grid.

W ash Background

Enable in Camera: Dulls background bitmaps in the Camera view. This allows 

you to see other elements clearly, such as the ones that have not yet been 

painted. 

Enable in Camera Drawing Mode: Dulls background bitmaps in Camera view 

while using the drawing tools. This allows you to see other elements clearly, such 

as the ones that have not yet been painted.

W ash Background Percentage: The W ash Percentage value.

Colour Space
Display Colour Space: The colour space in which to display the OpenGL preview 

in the Camera view. 
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In OpenGL View mode, colours in original bitmap images are converted from the 

colour space selected in their layer properties to the colour space selected in this 

preference, w ithout getting converted to the project colour space first, and 

colours in bitmap and vector drawing layers are not converted at all. 

In Render View mode, this preference is not used. However, this option is also the 

default colour space selected in the drop-down at the bottom of the Camera view 

when adding a Camera view to the workspace or when resetting or switching 

your workspace, and the colour space in this drop-down is the one used in Render 

View mode. 

Control Points

Show Control Points On Selected Layers: By default, when you select an 

element w ith the Transform tool, the motion path related to the object is 

displayed.

Control Point Tension: The default Tension value for new keyframes and control 

points.

Control Point Continuity: The default Continuity value for new keyframes and 

control points.

Control Point Bias: The default Continuity value for new keyframes and control 

points.

Preview W ash

Enable For Out of Date Previews: W hen you disable the automatic render 

preview, you must click the Update Preview button  in the Rendering toolbar or 

the Camera view bottom toolbar in order to recalculate and update the preview. 

W hen this option is enabled, if the current render preview is out of date and 

requires you to press the Update Preview button, the Camera view will display 

the current preview as washed out colours.

W ash Background Percentage: This is the value, in percentage, by which the 

outdated preview will be washed out.

Inverse Kinematics

Min/Max Angle Constraint W eight: This value acts similar to the Stiffness 

setting in the Inverse Kinematics Properties panel. This option only affects the 

minimum and maximum angle values set using the Min/Max Angle Mode. The 

higher the value, the stronger your need to move the body part to approach the 

minimum and maximum values set. Although the maximum value goes up to 1.0, 

in a production setting, the most practical value to use would be closer to 0.1. 
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Node View Preferences

Parameter Description

Navigator

Show Navigator: Shows or hides the display of the Navigator in the Node view 

when starting Toon Boom Harmony Premium.

Navigator Starting Corner: Indicates which corner is the default Navigator 

position.

Magnifier

W idth Multiple: Sets the w idth of the magnifier in tenths of the Node view width. 

Values range from 0.1–10.

Aspect Ratio: Sets the w idth to height ratio of the magnifier. Values range from 

0.1–10.

Opacity: Sets the transparency of the magnifier. Values range from 0–100. A 

value of 100 makes the magnifier completely transparent. A value of 0 makes the 

magnifier completely opaque.

Options

Default Thumbnail Background Colour: The default background colour when 

displaying the thumbnail of a node in the Node view. 

Middle Mouse Button Pans the View: Lets you use the middle mouse button to 
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pan the Node view.

Double Click on a Node Opens the Editor: Lets you open a node's property 

editor by double-clicking. 

Two Colour Cables for Pass Through Connections: W hen enabled, cables 

coming from a Composite node w ith its Mode property set to Pass Through w ill 

display w ider and in two shades of blue to distinguish them from other image 

cables. These cables carry several layers of image information, whereas image 

cables usually carry a single layer of image information. 

Default Thumbnail Resolution: The default horizontal and vertical resolution of a 

thumbnail, in pixels, when displaying the thumbnail of a node in the Node view.

Cable Type: Displays node connections as Line (straight) or Bezier (curves).

Port Output Ordering: Orders the Output Port Right to Left or Left to Right.

Port Input Ordering: Orders the Input Port Right to Left or Left to Right.

Layer Drawing Options

Antialiasing Quality: Smoothness setting applied to colour art. The higher the 

setting, the more antialiasing is applied. Higher quality images require more time 

to render and more system memory. Choose a lower quality if you are rendering a 

pencil test.

• Low: No antialiasing

• Medium Low: Some antialiasing

• Medium: Medium antialiasing

• High: Extensive antialiasing 

Antialiasing Exponent: Controls the amount of area around the Line and Colour 

Art edges used in the antialiasing process. A higher value uses less area, 

resulting in sharper edges, while a lower value uses more area, resulting in softer 

edges. If the Antialiasing Quality value is set to Low (no antialiasing), this value is 

ignored.

Read Colour: Controls the production of colour information from bitmap images. 

If this node reads 3 or 4-channel bitmaps, this selection determines whether the 

colour should be read or ignored. If this node reads 1-channel bitmaps, this 

selection determines whether the channel should be read as colour. W hen this 

option is selected w ith 1-channel images, the result w ill be a greyscale image.

Read Transparency: Controls the production of alpha information from bitmap 

images. If this node reads a 1 or 3-channel image, this option w ill create a matte 

from the colour values in the image. If the node reads a 4-channel image and this 

option is not selected, the alpha information in the image w ill be ignored.

Alignment Rule: The Alignment position for the element node. The new element 

node w ill be created follow ing this default rule of alignment.

Transparency Type:
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• Premultiplied with Black: The colour values of semi-transparent pixels in 

the image have been encoded so that the more transparent they are, the 

closer to black they are. W hen an image that is premultiplied w ith black is 

loaded in a software that does not support transparency, it appears 

blended w ith a black background. Select this to make Harmony reverse 

this premultiplication so that the image blends properly w ith other visual 

elements in your scene.

• Straight: The colour of semi-transparent pixels in the image is encoded 

independently from their transparency. W hen an image that is not 

premultiplied is loaded in a software that does not support transparency, 

semi-transparent pixels simply appear fully opaque, making its edges 

appear pixelated. 

• Premultiplied with W hite: The colour values of semi-transparent pixels 

in the image have been encoded so that the more transparent they are, the 

closer to white they are. W hen an image that is premultiplied w ith white 

is loaded in a software that does not support transparency, it appears 

blended w ith a white background. Select this to make Harmony reverse 

this premultiplication so that the image blends properly w ith other visual 

elements in your scene.

• Clamp Colour to Alpha: This is the same as Premultiplied with Black, 

except that it also prevents the colour values for a given pixel from 

being higher than that pixel's alpha value. This option is only useful if 

you are working with images that are supposed to be premultiplied 

with black, but where the colour values of pixels have been increased 

without their alpha values being adjusted accordingly. 

Art Layer Options: Allows you to select the default art type (Vector or Bitmap) 

for each type of art layer (Line Art and Colour Art), when creating a new drawing 

layer.

NOTE 

If you have the Support Overlay and Underlay Arts preference of the 

Advanced tab enabled, you can also select the default art type for those art 

layers (Overlay Art and Underlay Art)
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Exposure Sheet Preferences

Parameter Description

Filtering

These preferences are used to display or hide certain layer types in the Xsheet 

view.

Show Drawing Columns: Displays the Drawing layers in the Xsheet view.

Show Sound Columns: Displays the Sound columns in the Xsheet view.

Show Annotation Columns: Displays the Annotation columns in the Xsheet view. 

Show 3D Path Columns: Displays the 3D Path columns in the Xsheet view.

Show Function Columns: Displays the Function columns layers in the Xsheet 

view. 

Show Selection: Sets the Show Selection option On or Off by default in the 

Xsheet view. 

Centre on Current Frame: Turns auto-centering on or off when playing back a 

scene.  Auto-centering is used during sound breakdown with the ShuttleXpress 

device.

Options

Default Add Columns: The default position where the new column will be 

added.

Default Column W idth: The default w idth value for the new column being 

created.
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Drawing Creation

Use Current Frame as Drawing Name: Automatically names the drawing 

corresponding to the frame position. This avoids numbering conflicts while 

animating.

For example, using the default preferences, you start w ith the first drawing on 

frame 1, this drawing is called 1. You then draw the extreme position drawing on 

frame 10, this drawing is called 2. Next, the in-between pose is drawn on frame 

5, this drawing is called 3 and so on.  

At the end, you have a sequence like this: 1-9-4-6-3-8-5-7-10-2.

Instead, using the Use Current Frame as Drawing Name option, each drawing is 

automatically named by its frame number and the sequence looks like: 1-2-3-4-

5-6-7-8-9-10.

Extend Exposure of Previous Drawing: W hen drawing on a blank frame, a new 

drawing is created and the timing is extended from the previous exposed 

drawing.

Zoom Levels

You can set the minimum and maximum zoom levels to view the Xsheet, 

depending on the number of columns and rows in the project. Once you set a 

level, close and reopen the Xsheet so the new values take effect.

Minimum Zoom Level: Lets you set the lowest level of zoom. Choose a value 

between 1 and 6.

Maximum Zoom Level: Lets you set the highest level of zoom. Choose a value 

between 14 and 20. 
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NOTE 

You can set a keyboard shortcut to view the entire Xsheet.

Function Editors

Show Grid: W hen selected, the grid is displayed by default when opening the 

Function Editor.

Use Constant Z By Default: W hen selected, the Constant Z option w ill be 

enabled by default in the Function Editor.

Constant Z means that even when creating Motion keyframes, the Z function w ill 

use Stop-Motion keyframes and w ill not be interpolated, this can be very useful 

for cut-out animation. The Constant Z feature only works w ith 3Dpaths.

You can also enable the Constant Z option directly in the Function Editor or 

Function view for specific functions.

Gestural Drag
Default Setting for Gestural Drag: This is the default value enabling gestural 

dragging of cells in the Xsheet view.

Apply/Next

From Left to Right: W hen clicking the Apply/Next button in the Xsheet view 

Column Properties, the next column to be displayed in the Column Properties w ill 

be the one on the right.

From Right to Left: W hen clicking the Apply/Next button in the Xsheet view 

Column Properties, the next column to be displayed in the Column Properties w ill 

be the one on the left.

New Element

Bitmap Format: By default, when you create a new empty bitmap column, it w ill 

use the file format indicated in the field as the new column format. The default 

value is SCAN, which means that it is set for scanned-in drawings.

 

Scan Type: By default, the Scan Type is set to 2 which equals vector import. This 

means that the imported bitmap images w ill be placed into a Drawing layer. Scan 

type 1 is bitmap import. 
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Drawing Preferences

Parameter Description

Light Table

Light Table: Opacity (0,0-1,0):The maximum opacity value for the light table 

display (0 = transparent).

Light Table: W ash (0,0-1,0): The washed-out value for the light table display  (0 

= transparent).

Light Table: Enable Shade: W hen enabled, the drawings appearing on the Light 

Table are displayed in washed out colours in the Drawing view. W hen this option 

is disabled, the drawings appearing in the Light Table are displayed using normal 

colours. This option is for the Drawing view only.

Light Table: Shade in Camera View: W hen enabled, the drawings appearing on 

other layers are displayed in washed-out colours in the Camera view. W hen this 

option is disabled, the drawings appearing on other layers are displayed using 

normal colours. This option is for the Camera view only.

Enable Onion Skin for Other Elements: In the Drawing View, when the Light 

Table is enabled, making other layers visible alongside the current layer, this w ill 

make the Onion Skin for other visible layers appear alongside the Onion Skin for 

the current layer. Drawings for elements above the current layer w ill appear in 

blue, and drawings for elements below will appear in yellow. 

31

Harmony 22 Premium Preferences Guide                          



Preferences Dialog Reference

NOTE 

The drawings from other elements that get displayed in the Onion Skin are 

the drawings that are exposed at the same time as the drawings displayed 

in the current layer's Onion Skin. 

Onion Skin Render Style:

• Original Colours: Drawings displayed in the Onion Skin are rendered 

using their real colours.

• Coloured:Drawings displayed in the Onion Skin are displayed in solid red 

if they are before the current frame, or in solid green if they are after the 

current frame.

• Coloured Outlines: Drawings displayed in the Onion Skin are displayed in 

red outlines if they are before the current frame and in green outlines if 

they are after the current frame.

Onion Skin: Maximum W ash Value (0,0-1,0): The maximum washed-out value 

for onion skinned drawings.

Onion Skin: Minimum W ash Value (0,0-1,0): The minimum washed-out value 

for onion skinned drawings.

Onion Skin: Maximum Opacity (0,0-1,0): The maximum opacity value for onion 

skinned drawings. (0 = transparent).

Onion Skin: Minimum Opacity (0,0-1,0): The minimum opacity value for onion 

skinned drawings. (0 = transparent).

Options

Grid On By Default: W hen opening the Drawing view, the grid displays 

automatically.

Brush Size Cursor: W hen this option is enabled, the brush tool displays the brush 

size as a circle around the cursor.

Synchronize Eraser and Brush: W hen enabled, changing any of the Brush tool's 

properties simultaneously changes the corresponding property for the Eraser tool 

to the same setting, and vice versa. Likewise, selecting a preset for one tool w ill 

apply this preset's properties for the other tool. 

Auto Gap Closing in Pixel Units: Disabling this option w ill cause your gap to be 

zoom dependent. Zoom dependent means that the more you zoom in, the smaller 

the gap you can close w ith the Close Gap tools. By enabling this option, you 

choose to make the gap display available in pixel units, which is not zoom 

dependent.

Default Multiwheel Colour Picker: Displays the Multiwheel Colour Picker 

w indow instead of the regular Colour Picker.

Auto Save Pencil Styles: W hen this option is enabled, new pens and pen styles 

are automatically saved.
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Sticky Eye Dropper: Keeps the Colour Picker’s Dropper tool active until it is 

released by clicking on the Dropper icon again.

Desk Location: Defines the location of the Desk panel in the Drawing view.

Morphing Quality: Sets the default quality value for the morphing sequences. If 

you change this value, it w ill not affect the morphing sequence which was created 

previously. After a morphing sequence has been created using this default quality 

value, its quality can be changed manually by using the Morphing Tool Properties.

Auto Gap Closing on Startup: The values for automatic gap closing while 

painting drawings are: 0 = Disabled, 1=Small, 2=Medium, 3=Big.

Pencil Lines Opacity (%): Lets you set the default tranparency of your pencil 

l ines.

Create New Colour Pots Using Default Colour:  Set the default colour for 

creating a new colour swatch. Enable the option so that this default colour is used 

each time you add a new colour in your palettes. This option is useful for when 

you create new colour pots so that a more recognizable colour is created and not 

just a duplicate of the currently selected colour. Choosing a colour that is the 

opposite of your intended colour palette is recommended, such as grey if your 

palette w ill be fil led w ith bright, primary colours.

Zoom

Enable Paper Zoom: Enabling this option allows you to set the 100% Zoom level 

onscreen, in order to physically match the measurements of your paper drawing.

Number of Pixels per Inch: Enter the PPI for your monitor. To obtain the PPI of 

your screen, divide the height or w idth of your monitor's resolution setting by the 

corresponding physical height or w idth  of your monitor screen (resolution height 

divided by physical height, or resolution w idth divided by physical w idth) in 

inches.

Quick Close Up Zoom Factor: Sets the zoom level for the Quick Close up Zoom 

keyboard shortcut. 

Maximum Zoom Factor: Sets the maximum zoom level for the paper zoom.

Default Texture Pixel 

Density for Vector Drawings

Pixel Density: Determines the amount of pixels to store in textured brush strokes 

for each pixel that displays when the drawing is not zoomed in or scaled up. For 

example, at 100%, zooming in or scaling up textured brush strokes w ill make 

them lose texture quality. If set to 200%, textured brush strokes can be zoomed in 

or scaled up until they're tw ice their original size w ithout losing picture quality.
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NOTE 

This setting is applied to your scene's drawing resolution settings when 

creating a new scene, which is then applied to every new vector drawing 

created in your scene. Therefore, to apply changes to these settings to an 

existing scene, they must also be changed in the Drawing Resolution tab of 

the Scene Settings dialog. To apply changes to these settings to existing 

drawings, they must be changed using the Change Vector Drawing Brush 

Resolution dialog available from the Drawing top menu.

Default Canvas for Bitmap 

Layers

Canvas W idth: The default w idth of the canvas when creating drawings in a 

bitmap drawing layer. The percentage is relative to the w idth of the scene. Its 

default value, 200%, makes the w idth of the canvas tw ice the w idth of the stage. 

Canvas Height: The default height of the canvas when creating drawings in a 

bitmap drawing layer. The percentage is relative to the height of the scene. Its 

default value, 200%, makes the height of the canvas tw ice the height of the 

stage.

Pixel Density: Determines the amount of pixels to store for each pixel that 

displays on the screen when the drawing is not zoomed in or scaled up. For 

example, at 100%, zooming in or scaling up a bitmap drawing w ill make it lose 

picture quality. If set to 200%, bitmap drawings can be zoomed in or scaled up 

until they're tw ice their original size w ithout losing picture quality.

NOTE 

These settings are applied to your scene's drawing resolution settings when 

creating a new scene, which are then applied to every new bitmap drawing 

created in your scene. Therefore, to apply changes to these settings to an 

existing scene, they must also be changed in the Drawing Resolution tab of 

the Scene Settings dialog. To apply changes to these settings to existing 

drawings, they must be changed using the Change Bitmap Drawing 

Resolution dialog available from the Drawing top menu.

Pixel Density Proportional to Camera: By default, the pixel density of new drawings is set to the scene's default 

pixel density. W ith this option enabled, the pixel density of new drawings is set to the scene's default pixel density 

multiplied by the camera's zoom factor. 

For example, if this option is enabled and you create a new drawing while the camera is zoomed in at 6 fields (200%) 

and your scene's default pixel density is set to 150%, the new drawing w ill have a pixel density of  150% x 200% = 

300%.
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NOTE 

The factor by which the pixel density is multiplied is rounded to the nearest power of 2, ie: 25%, 50%, 100%, 

200%, 400%, etc. The rounding is done on an exponential curve. This means that, for example, if the scene's 

default scale factor is set to 100% and the scene is currently zoomed it at 9 fields (150%), a new drawing w ill have 

a 100% pixel density, as the multiplier w ill be rounded down from 150% to 100%. Hence, even if you enable this 

option, you must set your scene's default pixel density to at least 200% to prevent pixelated drawings. 
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Timeline Preferences

Parameter Description

Defaults

Show Groups: Displays the Group layers in the Timeline.

Show Effects: Displays the Effect layers in the Timeline.

Show Sound: Displays the Sound layers in the Timeline.

Show Sound W aveforms: Displays the imported sounds waveform in the 

Timeline.

NOTE 

You can always toggle the visibility of the waveform in the Timeline view by 

adding the Show Sound W aveform  button from the Toolbar Manager. This 

button w ill work whether you have the Show Sound W aveform option 

enabled or disabled in the Preferences panel.

Show End of Scene Marker: Displays the red bracket that delineates the end of 

your scene in the Timeline view. If you know that many different hands w ill be 

working on your scene, you may want to deselect this option so the scene length 

is not increased or decreased by accident.

Reduce Indentation: W hen this option is enabled, the horizontal indentation for 

parented nodes in the Timeline is reduced to optimize the amount of space taken 

in the Timeline. W hen you have a cut-out character and there is a long cascade of 

parented nodes, you can enable this option so the Timeline (left side) does not 
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have expand too w ide to see all your nodes.

Always Display Unconnected Nodes: Enable this preference if you prefer to see 

elements in the Timeline that have not yet been connected to a particular Display, 

even when in Normal View mode. This preference is not on by default.

Paste/Drag & Drop

Add Keyframes at Beginning and End: Copies and pastes a set of frames that 

includes an interpolated sequence between two keyframes, but only extracts a 

partial section. Under normal circumstances, cutting and pasting a function 

w ithout either the start or end keyframe would render the function null. This 

option caps the partial function w ith a new keyframe when you perform the paste.

Overwrite exposures and keyframes during drag and drop:W hen enabled, 

dragging and dropping drawings and keyframes in the Timeline view will 

overwrite the drawings and keyframes between the selection and the destination, 

as if the selection "w iped" everything on the way to the destination. 

NOTE 

W hether this option is enabled or not, dragging and dropping a selection of 

drawings w ill always overwrite the drawings at the destination w ith the 

drawings in the selection. This option only changes what happens w ith the 

drawings between the selection and the destination. 

Drawing Substitution

Create Key Exposure: W hen enabled, changing the drawing at the current frame 

using the Drawing Substitution panel of the Library view will always create a key 

exposure at the current frame, even if the drawing is the same as the drawing in 

the previous frame. If disabled, a key exposure is only created if the drawing at 

the current frame is different from the drawing in the previous frame. If the 

drawing at the current frame is the same as the drawing in the previous frame, 

the exposure of the drawing in the previous frame is extended over the current 

frame.
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Template Preferences

Parameter Description

Paste/Drag & Drop

Always Create New Drawings: By default, when you import timeline templates 

in the right section of the Timeline view, to stack them, the system will analyze 

and create only the non-existing drawings and only expose the existing ones. 

W hen enabled, this option automatically creates new drawings for every one of 

them that is exposed.

Palettes:

• Ask User: W hen dropping a template into a scene, the system will ask if 

you want to link the palette to the original or create a local copy in the 

scene.

• Use Original Palette: The system will automatically link drawing 

elements to the original palette file. If the original palette is not 

encountered a local copy w ill be created.

• Use Copy of Palettes: The system will automatically create a local copy 

of the palette in the scene.

Editing Template

Generate Thumbnails Automatically: Automatically create thumbnails for the 

template when you want to see the thumbnails in the Library or when saving a 

template modification.
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Sound Preferences

Parameter Description

Settings

Analog Sound Scrubbing: Switches from digital to analog sound scrubbing.

Analog Jog Speed: Lets you control the sensitivity of the jog slider or dial. Choose 

a value between 1 and 20. The higher the jog speed value, the slower you can 

scrub to have the sound play at an average pace.

Analog Jog Dampening: Lets you choose a value between 1 and 100 for the 

Analog Jog Dampening. The higher the value, the less precise Harmony is at 

responding to the jog's changes in speed. However, the more smooth the play 

back is using the jog slider or dial.
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OpenGL Preferences 

Parameter Description

Settings

Conservative Texture Management: Turns on and off conservative memory 

management for bitmap texture files. Performance w ill improve when this is 

enabled. If disabled, you w ill have a better on-screen rendering of bitmap files at 

the expense of slower performance.

Smooth Textures: Smooths out the pixels of bitmap images when zooming in; 

this improves bitmap image quality.

Alternate Gradient and Cutter: This is an alternative way to disable write in the 

OpenGL Backbuffer, required for some video cards (i.e. GeForce FX5200). Do not 

enable this option unless you are experiencing problems with gradients and 

cutters in OpenGL.

Support Desktop Effects: Enable this option for better compatibility w ith 

W indows 7, W indows Vista and Mac OS X desktop effects. This w ill prevent 

graphic compositing problems from happening when the full-scene anti-aliasing 

option is enabled.

Enable Mipmapping on Bitmap Layers: Generate anti-aliased mipmap textures. 

40



Disable this option for increased performance when working on Bitmap layers 

w ith non-standard graphic cards. 

Maximum Texture Size: The size that the bitmap file w ill be reduced to when 

using the Conservative Texture Management.

Texture Memory: The amount of temporary memory used to store bitmap texture 

files.

Vector Drawing Maximum Texture Size: This is the size that the .tvg file w ill be 

reduced to for better performance when in OpenGL render mode.

Full Scene Antialiasing

The follow ing options allow you to configure the way drawings are previewed in 

Harmony. 

Enable              (Requires Relaunch)             : By default, drawings displayed in Harmony, such 

as in the Camera or Drawing view, have no antialiasing and display hard pixels at 

the edge of strokes and lines. If this preference is enabled, antialiasing w ill be 

done through the graphic card to enhance the quality of drawings and make a 

preview that resemble the final render more closely. This may impact application 

performance negatively. 

Number of samples: The amount of times the OpenGL preview is scaled up 

before processing it for antialiasing. The higher this value is, the better the 

antialiasing quality w ill be but the heavier it w ill be on the machine's resources. 

NOTES 

 l It may be necessary to restart the application to see the effects after 

changing either of these settings. 

 l These settings may be overriden by the 3D antialiasing settings of the 

driver for your graphics card. If changing these settings and restarting 

the application seems to have no effect, make sure your graphics card 

supports antialiasing, that antialiasing is enabled and that it is 

configured to let applications control their antialiasing. 

 l These settings only affect the way drawings are previewed in OpenGL. 

They have no effect on the final rendered image, or on the way the 

image looks when setting the Camera view in Render Preview mode.

Playback Images

Enable Playback Caching: Enable the caching of OpenGL previews for quick 

playback.

Playback Cache Size (in Mb): The maximum size of the cache used to store 

cached playback images. 

Drawings

Enable Textures in Pencil Lines: Controls whether textures applied on pencil 

l ines are rendered for the OpenGL preview. 

Enable Variable Line Thickness: Controls whether lines w ith a variable w idth are 

rendered w ith their variable w idth or w ith a constant w idth in the OpenGL 

41

Harmony 22 Premium Preferences Guide                          



Preferences Dialog Reference

preview. 

Effects

Enable Tone and Highlight: Controls whether Tone and Highlight effects are 

rendered in the OpenGL preview.

Enable Cutter: Controls whether Cutter effects are processed for the OpenGL 

preview.

Enable Composite Passthrough for All Effects: W hen this option is enabled, 

effects that display in the OpenGL preview are ordered based on the logic that 

w ill be used for the final rendered image, which may fix some issues w ith the 

OpenGL preview when using complex node systems comprised of effects and 

mattes. However, enabling this option may impact performance if the scene has 

effects that use a matte, such as the Cutter or Tone effect.

Enable Colour Override: Controls whether Colour-Override effects are rendered 

in the OpenGL preview.

Enable Glue Node: Controls whether Glue effects are rendered in the OpenGL 

preview.

Rendering Caching

Enable Rendering Caching of Composite Nodes: Controls whether non-

passthrough Composite nodes cache their composited image when Harmony 

generates an OpenGL preview. This is useful when the image generated by a 

composite is used several times in a scene, for example because a composite's 

output port is connected to several other nodes. If this preference is disabled, the 

composite w ill regenerate the preview for its node system for each of its outgoing 

connections. W hen enabled, the composite w ill generate the preview for its node 

system once, cache it, and output the cached image to its other outgoing 

connections.

Composite Cache Capacity (MB): The maximum amount of cache available to 

store images cached by Composite nodes. This cache is stored in the graphic 

card's video memory. If your machine has a lot of video memory, increasing this 

setting could enhance the performance of Harmony when working w ith heavy 

scenes. 

Enable Rendering Caching of CacheLock Nodes: Controls whether OpenGL 

Cache Lock nodes are used to generate the OpenGL preview. Disabling this 

preference has the same effect as disabling all OpenGL Cache Lock nodes in the 

scene.

CacheLock Cache Capacity (MB): The maximum amount of cache available to 

store preview images cached by OpenGL Cache Lock nodes. This cache is stored 

in the graphic card's video memory. If your machine has a lot of video memory, 

increasing this setting could enhance the performance of Harmony when working 

w ith heavy scenes.

OpenGL Node Cache Size in Memory: The amount of RAM, in megabytes, that 

Harmony is allowed to use to cache the OpenGL preview image of cached nodes. 

W hen Harmony uses up all the RAM in this preference, it starts caching the 
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OpenGL preview of cached nodes on the disk instead, which can significantly 

impact its performance.

OpenGL Node Cache Size on Disk: The amount of disk space, in megabytes, that 

Harmony is allowed to use to cache the OpenGL preview image of cached nodes 

when it used up all the RAM reserved for this purpose. 

NOTE 

If there is no more memory and no more disk space left to store the preview 

image of cached nodes, Harmony w ill not be able to cache every frame in 

the scene, which means it may have to regenerate the preview image of 

cached nodes when you scrub through the scene.
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Render Preferences

Parameter Description

Preview Options

Enable Blur: Renders blur effects derived from the Blur-Directional, Blur-Radial, 

and Blur-Variable in the Render View window.

Enable Line Texture: Renders line texture in the Render view.

Enable Focus: Renders focus effects from the Focus-Apply and Focus-Set nodes.

Render View Image Cache

Cache Size (Percentage of System RAM): The percentage of RAM on your 

machine to reserve for the Render View cache. 

Disk Cache: If enabled, Harmony w ill also use your machine's storage space to 

store Render View image cache, increasing its total capacity.

Cache Path and Capacity on Disk (in MB): You can use this field to specify one or 

several storage location for the Render View disk cache. If you do, you must 

specify the path and the desired storage limit of each location, in this format:

Directory path;Capacity (in megabytes)

If you want to specify several storage spaces, you must specify the path and 

capacity of each storage space, in this format:

Directory path 1;Capacity (in megabytes) of directory 
1;Directory path 2;Capacity (in megabytes) of directory 
2 
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NOTES 

 l This field is only accessible if the Disk Cache option is checked, as 

Harmony w ill not store a Render View cache on the disk otherwise. 

 l If this field is left empty,          Harmony's temporary directory w ill be used 

instead, and w ill not have a storage limit.

 l The specified directory or directories must already exist. 

 l You can use RAM disks as storage locations. 

Multi Threading

This lets you specify the level of parallel processing done during the final image 

calculation (soft-rendering). Allowing parallel processing speeds up the soft-

render process.

Number of Rendering Threads: Lets you specify the number of parallel 

processes during the soft-render process. A value of 1 disables the multi-

threading process because it specifies that only one rendering thread w ill be used 

during the process. The maximum number of threads is 64. The recommended 

starting value is 2 threads per CPU core, meaning that if you are using a 2 Quad 

Core CPU, the preferences should initially be set to 16 threads.

GPU

Enable Graphic Card Acceleration: Optimizes the rendering blurs by using the 

GPU's acceleration capabilities. This option is on by default.  Not all cards support 

this acceleration.
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Advanced Preferences
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Parameter Description

Advanced Options

Support Overlay and Underlay Arts: W hen enabled, options to manipulate 

overlay and underlay arts are available. 

Advanced Display: Enable or disable the Advanced Display mode.

Advanced Palette Lists: Lets you switch your palette list to Advanced Palette 

Lists mode for creating and storing palettes in the Scene or Element Palette List.

Restore Current Selected Drawing on Undo: If a drawing other than the current 

one is being affected by an Undo command, the affected drawing is displayed.

Advanced Element Mode: Displays more options in the Add Column dialog box 

and the Column Properties dialog box.

Auto-rename Elements: Controls whether to rename the element whenever the 

corresponding node name in the Node view or layer name in the Timeline view is 

changed.

Support CMYK in PDF/Illustrator Import: Lets you import .pdf and .ai files that 

were created or exported in CMYK mode. The colours of the resulting imported 

image may stil l not look 100% faithful to its CMYK original due to the RGB 

conversion. It is recommended that you convert these files to RGB images before 

importing them into Toon Boom Harmony Premium. Disabling this option w ill 

cause all the colours of the imported image to be displayed as red to indicate that 

the file was not converted to RBG before import.

PDF/Illustrator Import as Separate Layers: Imports  the different 

groups/elements of the .pdf or .ai file as separate layers. For Il lustrator files, the 

import w ill use the top level group as separate layer names. Deselect this option 

to import pdf or .ai files as a single layer.

Element Node "Animate Using Animation Tools" Default Value: If you know 

that you prefer to work in the style of version 7.3 or earlier, or if you intend to 

substitute many drawings throughout your animation, you might w ish to deselect 

this option. This way, you won't have to do it every time (through the Layer 

Properties) for each new drawing layer that you create.

Compress Saved Keyframes: Compresses keyframe values when there are no 

changes between adjacent keyframes. The resulting project is not compatible 

w ith versions of Harmony prior to version 11. 

Enable Logging of IO Operations: W hen enabled, Harmony w ill create a log of 

every file operation it performs in a log file in the logs subfolder of the scene 

folder.

Enable Camera View Performance Report: Displays debugging information in 

the Camera view so that you may see the performance of the application as well 

as the rig being rendered.

Enable Middle Button Pans View: W hen enabled, clicking and dragging the 

Drawing or Camera view with the middle mouse button w ill pan it. 
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Follow Node View Parenting for Node Navigation: W hen using the keyboard 

shortcuts, Select Parent Skipping Effects (B) and Select Child Skipping Effects 

(Shift + B) to navigate the hierarchy of a scene, the hierarchy as it appears in the 

Timeline view is used by default. W hen enabled, the hierarchy as it appears in the 

Node view is used instead. 

Use a Donut-Style pivot in the Transform Tool: Creates donut-style holes in the 

centre of pegs that allow you to select the anchor points directly behind the pivot 

point w ithout moving the peg first.

Allow Temporary-Pivot dragging in the camera view: Disables the interactive 

manipulation of the Transform Tool pivot.

Event processing interval while running scripts: W hen a Harmony script is 

executed, this setting determines at which interval, in mill iseconds, Harmony 

should pause the script to see if the user attempted to do something, and to 

respond accordingly. 

For example, if the setting is set to 1000, and the user starts running a heavy 

script that takes several seconds to execute, Harmony w ill pause the execution of 

the script every second to check if the user pressed any key or clicked on anything, 

and w ill respond accordingly, making Harmony responsive despite running a 

heavy script. This also allows the script debugger to detect if the script has an 

infinite loop and to interrupt it if needed. 

The default value of this setting, which is -1, disables the processing of any event 

while a script is running until the script is fully executed. This means that if a 

script takes several seconds to execute, Harmony w ill "hang" until the execution 

is over. This can cause Harmony to freeze if the script has an infinite loop. 

However, this has for an advantage that it prevents user action from making any 

changes or actions that could interfere w ith the script before it is done running. 

NOTE 

Disabling event processing during scripts can be critical when using Master 

Controllers, as they are often scripted to manipulate elements in the scene 

in response to user input that refreshes several times per second. If the user 

input refreshes too quickly for Harmony to fully execute the Master 

Controller script for every user input, this may cause the execution of the 

script to be paused recursively. 

Default Colour Editor: The type of colour editor to use in the Layer Properties of 

effects that have colour parameters. This setting is applied to new effects added 

to a scene, but not to existing effects. Harmony supports the follow ing types of 

colour editors:

 l Separate Channels: Displays a simple input field and a function button for 

each of the Red, Green, Blue and Alpha channels, w ith a preview of the 

resulting colour below.
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 l Colour W heel: Displays compact "click and drag" style input fields for the 

Alpha, Hue, Saturation, Value, Red, Green and Blue channels. The the 

input fields can be clicked and dragged left and right to decrease or 

increase their values, or double-clicked to type their value in. Each channel 

also has a toggle button allowing you to select one of the channels, and to 

the right is a visual colour picker which allows you to visually pick the 

value of that selected channel. To the bottom-left is a control to navigate 

the existing keyframes of the colour functions, as well as add or remove 

keyframes at the current frame. 

 l Compact: Displays a single slider control for the Alpha channel of the 

colour along w ith a function button for the alpha channel. To the right are 

buttons to navigate existing keyframes in the alpha function as well as to 

add or remove keyframes on the alpha function at the current frame. To 

select the actual colour, you must double-click on the colour preview to 

open the colour picker. This editor only allows you to animate the alpha 

value, and hence should not be used if other channels must be animated. 

TIP 

In any of the colour editors, you can double-click on the colour preview to 

open a Colour Picker dialog, giving you access to more convenient visual 

controls to select a colour. 

Tablet Support
Use Qt W intab Tablet Support (Requires Relaunch): If you are using a tablet 

other than W acom, deselect this option (and relaunch) if you are having issues 
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with offset or pressure sensitivity.

Unicode

Allow Unicode Names: Lets you use up to 120 ASCII characters for names of 

environments, jobs and scenes. This means you can use characters for languages, 

such as Japanese, Chinese, French, Spanish, and others, characters for names in 

your database setup.
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Deformation Preferences

Parameter Description

Scale Controls

The Scale controls let you customize the appearance of the Deformation-Scale 

and Deformation-Uniform-Scale controls by setting the distance from the 

deformer axis.

Display Scaling Node in Pixel Size: This option is disabled by default. The 

distance between the controls and the deformer axis is calculated using fields as 

a value. Select this option to change the value to pixels.

Scaling Pixel Size: The default value is 64 pixels, meaning the distance between 

the controls and the deformer axis is 64 pixels. You can enter any pixel value.

Scaling Field Size: The default value is 2 fields, meaning the distance between 

the controls and the deformer axis is 2 fields. You can enter any field value.

Deformation Convert 

Deformed Drawings

Texture Resolution when Converting Gradient and Textures: Sets the size of 

the bitmap texture used during the conversion of deformed drawings to 

drawings. The maximum value accepted is 2048 pixels.

Drawing Layer

Default Pencil Line Deformation Quality: The Pencil Line Deformation Quality 

setting applied to new drawing layers. This setting is set to Low by default 

because the increase in quality in higher settings is very rarely visible, except w ith 

extreme deformations in ultra high definition renders.

TIP 

You can change this setting for individual drawing layers. In the Layer 

Properties of a drawing layer, look for the Pencil Lines Quality setting in the 

Deformation section of the Line Thickness tab. 
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Particle Preferences

Parameter Description

OpenGL

Always Show Particles as Dots: Displays the particles as dots in the OpenGL 

preview mode. This makes the playback speed faster for a heavy scene.

Horizontal Resolution of Image Fracture Input: This is the size, in pixels, of the 

proxy bitmap image rendered in OpenGL when using the Image Fracture particle. 

A smaller image size increases the playback speed in heavy scenes.
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